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this document. It explains what WhereDidAllMyMoneyGo? is 
and how to use it. This document contains four sections : 

- A tutorial to teach you how to use WhereDidAllMyMoneyGo?.
- Some theoretical background : what is WhereDidAllMyMoneyGo? and what is double entry accounting
- A description of all the data to set-up
- Miscellaneous tips and techniques 

Although the original version of this document was corrected by Dave Low – thank you Dave – I have been updating this document afterwards to
bring it in line with version 1.0. So spelling and grammar mistakes did sneak in again. Please apologize for this : English is only my third 
language and as I am currently still in start-up mode - having to combine Mac development and being-a-father-and-husband with a more-than-
full-time job as It-consultant in the Wintel world - I just do not have the resources (yet?) to pay a technical writer. Know that things can only get 
better in the future!

3 Tutorial

This section teaches you how to use WhereDidAllMyMoneyGo?.
If you have some basic knowledge of accounting, it is probably 
everything you ever need to read. You'll be guided trough the 
creation and the set-up of a new file and the creation of some 
transactions. This tutorial is completed by a 'Tutorial' example 
file. That file is placed in the same folder as your copy of 
WhereIst? (WhereIst? is the short name of 
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WhereDidAllMyMoneyGo?. We will use both names in the rest of
this document). It contains all the transactions described in the 
tutorial plus some extra examples. Please check it out! If you 
get lost in the tutorial, you can always look at the solution there.

3.1 The Case

Imagine you are a citizen of the USA. You have a job (2000 dollars per month) and rent a 
house (500 dollars per month). All the money you earn is placed on a bank account. At the 
end of every month, you transfer 500 dollars from your bank account to your savings 
account. You keep some money in your pocket for small daily expenses. 
You are considering investing some of your money in BertTorfs shares. These shares are 
quoted in Belgian Franks on the Brussels Stock Exchange. One BertTorfs is worth 2000 
Belgian franks. As 100 Belgian franks are worth 3 dollars, one BertTorfs sells for 60 dollars.

3.2 Conventions Used In thisTutorial

The following conventions are used trough this manual: 

- Menus are represented as <Menu=>MenuItem>
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- Field labels are represented as 'Text Label'
- Text you have to type yourself represented as 'This is text you have to type'
- Keys that are to be pressed together are represented as <Command-K>
- Keys that are to be pressed one after the other are represented as <Shift><A>

3.3 Lets Go

Ready to go? Then double-click the WhereDidAllMyMoneyGo? icon. WhereIst? will start and
a new document will be created automatically. First thing to do is setting things up. This 
includes setting up currencies, accounts and expense types. Lets start with the currencies:

3.3.1 Define the Currencies

First of all, we must define the currencies we need. We need at least three currencies: 

- American Dollars (Your home currency).
- Belgian Frank (You invest in shares expressed in Belgian Franks).
- BertTorfs : Shares are treated as just another currency by WhereIst?.

To set them up, we open the currency dialog (select <Set Up - Currencies> from the menu).
Every time WhereIst? creates a new document, it automatically inserts one currency :  your home currency. Its name is copied from the 
international settings of your machine. If you are living outside the USA, that name is probably not 'American Dollar', so you should change both
the short and the long name of your default currency. Here is how: 

- Open the currency dialog (if not yet done) by selecting the menu <Set Up=> Currencies>

If you want to learn more about the different items on the currency dialog, turn on balloon help and point your mouse to the items you want to know
about. Balloon help is implemented in almost every dialog of WhereIst? You can toggle balloon help on and of using the keyboard shortcut <Shift-
Help>.

- Press <Tab> to move to the short name field. You can move between the different fields on the dialog by pressing the <Tab> key
(<Shift-Tab> will bring you back to the previous field). 

- Change the short name of your home currency to 'AMD'.
- Press <Tab> again.
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- Change the long name to 'American Dollar'. You can ignore any other field.

The two other currencies - Belgian Franks and BertTorfs - are to be created from scratch. To create a new currency, you can either 

- Press <Command-K> or Select <Edit->New Currency…>.

The <Command-K> shortcut is one you should remember. It creates new objects in all of the dialogs of WhereIst?. Alternatively, you can use the
‘New…’  command  from  the  edit  menu.  The  text  of  that  menu  item  is  updated  whenever  you  switch  between  the  different  dialogs  of
WhereDidAllMyMoneyGo?, so it always tells you which kind of object you’ll be creating.

- A new currency named '???' will be created. The cursor will be positioned automatically on the currency’s short name. Change it
to 'BEF' 

- Press <Tab> to move the cursor to the name field. Type 'Belgian Frank'. 
- Press tab again. This will bring you to the first part of the conversion factor. Type 100. 
- Press tab again. Enter ‘3’ as a value for the second part of the conversion factor. The complete conversion factor should  be

'100 BEF = 3 American Dollar'. 

- Leave all other fields unchanged for the time being.

Creating the third currency is a little (just a little) more difficult. Here is what you should do: 

- Press <Command-K> to create a new currency.
- Type 'BT' as the short name.
- Press <Tab> to move to the second field (the full name).
- Type 'BertTorfs Stock'
- Click the radio button preceding the label 'Stock Expressed In'. As a result of this, the field following that label will be enabled.
- Press <Tab> to go to that field. As soon as that field gets selected, a list showing all currencies currently defined will pop up.
- Select or use the <arrow-up> and <arrow-down> keys until the currency named 'Belgian Frank' is highlighted. Press <enter> (or

<tab>) to close the pop-up list and select the highlighted currency.
- Press <Tab> again. This will bring you to the conversion amount.
- Specify that 

'1 BT = 2000 Belgian Franks'.

- You can leave all other fields unchanged.
- It is a good idea to press <Command S> now to save your work.
- Name your file whatever you want
- And you are done creating currencies.
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There are five ways to select an item from a popup-list

A popup-list

- Use the up- and down arrows to select the item you want. Press 'Tab' or 'Enter' to select the highlighted item.

- Click the item you want with the mouse. 

- Start typing the name of the item you want. WhereDidAllMyMoneyGo? will automatically scroll to the first item matching what you typed.
Press 'Tab' or 'Enter' to select the highlighted item.

- If you know the Id (the number) of the item you want, just enter it. . Press 'Tab' or 'Enter' to select item whose Id you typed.

- Drag the correct object from the dialog where you defined it onto the editable part of the popup list. This can be handy if you have to
select from a large list.

The currency dialog should look like this after you created BertTorfs:
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The currency dialog after the currencies have been created.

The button labeled 'Allow Decimals' does not yet have any effect in the current release (1.0) of WhereDidAllMyMoneyGo?.
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3.3.2 Define the accounts

Next we define accounts. Accounts are containers that hold value. Accounts are the heart of WhereIst?. In our 
example, we need to define four accounts: 

- Your Bank Account
- Your savings account
- Your pocket
- Your BertTorfs shares.

You open the account dialog by selecting the <SetUp=>Accounts>.
When you open the account dialog, you'll notice that WhereIst? inserted some default accounts for you. You can just ignore them for the time 
being. WhereDidAllMyMoneyGo? uses these accounts as default accounts for some special transactions. 
Defining accounts is quite similar to defining currencies. New accounts are created by pressing <Command-K> or by choosing <Edit->New 
Account…> from the menu. 

You can delete existing accounts. To keep everything balanced, all transactions that either debit or credit that account will be deleted as well. Handle
this feature with care! 

Accounts are the only objects in WhereIst? that can be numbered manually. This was done so you can adapt your account numbers to any official numbering 
scheme, as long as it is a numeric one. We will not change the Id's of the accounts in this exercise. 

- Open the account dialog by selecting <SetUp=>Accounts>
- Press <Command-K> to create a new account.
- Press <Tab> to move from the 'Id' field to the 'Name' field. Change the name to 'Bank Account'.
- Press <Tab> to move to the ‘Type’ popup list.  Select 'Own Property'. 
- - The 'Account Number' field can be used to hold the number assigned by your bank. 

You can leave all other fields unchanged.

The only way you can change the balance of an account in WhereDidAllMyMoneyGo? is by creating a transaction. Even when you enter or change the
balance of an account using the account dialog, a transaction will be generated to perform the actual update. So when you would have typed in
'500', WhereIst? would generate a transaction to update the balance of your bank account. You can take a look at these generated transaction via
<Transactions =>Transactions Complete> or via the <Overview=>Bookings Per Account>.

The three other accounts are created the same way. All three are 'Own Property' accounts. Your savings account and your pocket-money account are expressed 



WhereDidAllMyMoneyGo : User Guide Page 11
in American Dollars. The account that will hold your BertTorfs shares is expressed in 'BertTorfs'. The currency into which an account is expressed can be selected 
from the ‘Currency’ popup list.

When you are done creating accounts, the dialog should look like this:

The account dialog when you are finished creating some accounts. Note that the BTShares account is expressed in BT!

3.3.3 Define Expense Types

The final objects to set-up before we can start entering transactions are the expense types. Expense types express reasons why you
spent or earned money. Define following expense types : 
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Name Mastertype (Popup List)

Salary Income

Interest on My Capital Income

Food Expense

Electricity Expense

Rent Expense

Computer Equipment Expense

Clothing Expense

Be careful when you create the first two ones : do not forget the change the master type from the initial 'Expense' to 'Income'. The type can be 
set using the radio buttons. When you are done creating these expense types, the dialog should look like this : 
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And now we are ready to…

3.3.4 Enter transactions

Lets start with a simple transaction…

3.3.4.1 First Salary

At April 28, 1997, you got your first salary - whaaaaw! As you are very motivated to keep track of where all your money comes 
from and goes to, you boot up your Mac and enter your first transaction.
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Any transaction can be entered with the 'Transaction Complete' dialog. For your convenience, WhereIst? offers some simplified 
versions of this dialog. We will use one of these - the unspecified income dialog - to book your first salary.

If you want to track the source of all money you gained, you'll have to define an account for each and every of these sources. This may be the
preferred way for professional users, but for day-to-day home usage, it would be overkill. That is why WhereIst? has an account named 'Unspecified
Income'. It is meant as a replacement for all sources of money you don't care about. The Unspecified Income dialog is used to book money coming
from that 'Unspecified Income' account.

You can open the unspecified income dialog by selecting <Transactions=>Transactions Simplified=>Unspecified Income>. Press <Command-K> to create
a new transaction. Enter the following data: 

- Title : My first salary.
- Description : Whatever you like.
- Date : 28-04-1997 (or 04-28-1997 that is your normal date format. Check the ‘Date and Time’ control panel if

you want to know the format you’ll have to use. ).
- Currency : American Dollar
- Amount : 2000 (notice how the amount gets copied over to the details!)
- To Account : Bank Account
- To currency : Leave to 'AMD : American Dollars'
- To Amount : Leave at 2000.
- Expense Type : Select 'Salary'
- Expense Type Currency : Leave to  'AMD : American Dollars'
- Expense Type Amount : Leave to 2000

You'll notice that the four graphs on the main window update while you enter transaction. 

Maybe the biggest part  of  all  the money you earn  arrives at your bank account.  To make entering transactions easier,  you can specify that
WhereDidAllMyMoneyGo? should use your bank account as your default 'Own Property' account. This is done by selecting 'Bank Account' just next to
the 'Default Own-Property Account' label of the <File=>Preferences>.
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Selecting 'Bank account' as the default own-property account.
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The dialog should look like this when you are finished :

Entering your first salary using the 'Unspecified Income' dialog.

3.3.4.2 Saving For a Rainy Day

At the end of the month, you transfer 500 dollars to your savings account. Open the 'Unspecified Transfer' dialog to do this. 
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Enter the following data: 

- Title : Monthly savings.
- Description : Whatever you like.
- Date : 30-04-1997 (or 04-30-1997 if you enter dates that way).
- Currency : American Dollar
- Amount : 500 (notice how that amount gets copied over to the details!)
- From Account : Bank Account
- From currency : Leave to 'AMD : American Dollars'
- From Amount : Leave at 500. 
- To Account : Savings Account
- To currency : Leave to 'AMD : American Dollars'
- To Amount : Leave at 500.

You won't see the graphs change this time. Transferring money between your accounts does not change how rich you are.

You use the 'Unspecified Transfer' dialog to register all transactions that shift money between accounts. You will not be able to 
specify an expense type for an unspecified transfer. If you need to specify an expense type, you should use the 'Transactions 
Complete' dialog!

Second Salary (And third and fourth and fifth…)

As you’ll be earning 2000 dollars every month from now on, you can just instruct WhereIst? to generate that transaction 
automatically every month. So imagine your payday is the last Friday of the month. Here is what you should do: 

Go to the  ‘unspecified income’ dialog, select the transaction you just entered (your first salary) and press <Command-C>. (Yes, the 
normal copy command).
Now select ‘Transaction=>Recurring transactions.
Click on the list part of that dialog. This will un-highlight and un-select the transaction title field. If you do not select the list, the 
contents of the clipboard would be pasted in the transaction title. That is not what we want: we want the complete transaction to be 
pasted! 
Press <Command>+ <V> (Yes, an ordinary ‘Paste’). All the transaction details, debits, credits and expense types, are pasted.
Change the transaction date to ‘01-05-1997’ or ‘05-01-1997’, as long as it is May 1th, 1997.
Click the tab titled ‘How To Generate’.
Click the ‘Monthly’ radiobutton.
Select ‘Last’ and ‘Friday’ from the popup-menu’s. 
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All this together instructs WhereDidAllMyMoneyGo? to generate a salary transaction the last Friday of every month, starting from may the 1st, 
1997. The How To Generate tab should look like this when you’re done: 

When you close the dialog, nothing happens. WhereIst? only checks for automatic transactions every time a file is opened. If you want to check 
the result of the generation, close your file (do not forget to save!) and open it again. First thing you notice is the graph on the first screen. It is 
going up!.  If you want to see the generated transactions, open the ‘Transactions=>Transactions Complete’ dialog.

3.3.4.3 Buy BertTorfs shares

You heard about a young promising company called 'BertTorfs'. It has just been introduced on the Brussels Stock Exchange 
(Just dreaming :-!)  and you want to buy some shares. BertTorfs shares are currently traded at 2000 Belgian Franks, and 2000 
Belgian Franks are worth 60 dollars. You decide to buy 20 of them. The bank charges you 10 dollars expenses for the 
transactions. The total amount of the transaction (what you pay your bank) is 1210 dollars (20 times 60 dollars plus 10 dollars 
expenses). 
Here is what you have to enter. We use the 'Transaction Complete' dialog this time.
On the header you enter: 

- Title : 'Buying BertTorfs'.
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- Description : Whatever you like.
- Date : 31-07-1997 (31st of July 1997).
- Currency : American Dollar
- Amount : 1210 dollars (notice how the amount is copied over to the details!)

On the 'From' side, enter (or select)

- Account : Bank account
- Currency : American Dollars
- Amount : Just leave 1210 dollars

On the 'To' side, enter

- Account : BertTorfs Shares
- Currency : BertTorfs. The amount will be converted from 1210 to 20,17 (that is the number of shares you can get for 1210

dollars if the bank would not be charging you 10 dollars)
- Amount : Change from 20,17 to 20.

WhereDidAllMyMoneyGo? will notice that there is still 10 dollars missing. That is the commission you paid to the bank. A second 'To' detail will 
be created for that missing amount. Change the details to

- Account : Losses - Unspecified (that's the account that fits most what is happening).
- Currency : Leave to AMD (American Dollars)
- Amount : Leave 10 

Once the total of the 'To' side matches the header amount, WhereIst? will get you to the 'For' side of the transaction. You'll enter two lines there 
as well (or rather, WhereIst? will create them for you). Enter to following details

- Expense Type : Expense Unspecified
- Currency : AMD : American Dollar
- Amount : 10

and (after WhereDidAllMyMoneyGo? created a second line for the remaining 1200 dollars) on the second line you enter

- Expense Type : Transfer  Unspecified
- To Currency : AMD : American Dollar
- Amount : 1200
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Here is how it looks like when you are done : 

 

We have been using quite a lot of 'Unspecified Stuff' up to now. For home usage, this is OK. To track the financial performance of a company
however, it might be better to create specific accounts and expense types for each and every source, destination and reason of and for money flows.
For the share-buying example, you could e.g. use an account 'MyBank' as the to account, an expense type 'Commissions' to replace 'Unspecified
Income', and an expense type 'Investments' in stead of the 'Unspecified Transfer'.
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3.3.4.4 Withdrawal of Money

You take 500 dollars from your bank account and put it in your pocket. Use the 'Transactions=>Transactions : 
Simplified=>Unspecified Transfer' dialog to register this. Use the account named ‘Bank Account’, as the 'From' account and the 
account named ‘Cash’ as the 'To' account. Enter ‘September 5th’ as the date. (That is what I did when I created the tutorial file). If 
you prefer to use the 'Transactions => Transactions - Complete' dialog, you could define an expense type named 'Withdrawal' of 
type 'Transfer' to be used as expense type for this transaction. The tutorial file just uses the generic ‘Transfers – Unspecified’ 
expense type. (I personally do not care about classifying transfers.)

3.3.4.5 The Rent

We forgot to mention the rent. So enter the rent for the months of April up to now. Rent goes from your bankaccount to your 
landlord. The expense type is ‘Rent’. If you do not want to create your ‘LandLord’ as an account, you can use the generic ‘Losses
Unspecified’ account. In stead. Otherwise, you must create a profit and loss account named ‘LandLord’. 
Enter the rent as a recurring transaction that must be generated the 15th of every month starting from April 1, 1997. (Just look at 
the example file to see how I did it. I created the ‘LandLord’ profit&loss account.)

3.3.4.6 Go shopping

Now lets go shopping. We go the store and spend 550 dollars: 50 dollars on clothes, 150 dollars on food and 350 dollars on 
computer equipment. Below is a screenshot of the 'Transactions=>Transactions : Simplified => Unspecified Expenses' dialog with
what you should enter. Note how WhereDidAllMyMoneyGo? tries to help you when you enter transaction details.
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A shopping example.
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3.3.4.7 Interest

So you saved a lot of money during the year. As a result of this, your bank pays you generously 1000 dollars interest on your bank
account and 500 dollars interest on your savings account. Use the unspecified income to enter this transaction. Date it at December
31st. Create two transactions: one for the interest gained on your bank account and one for the interest gained on your savings
account. If you have any doubts on how to enter these transactions, you can take a look at the tutorial file.
When you are done, return to the main window (the one with the four graphs) and press ‘refresh’. The graphs are finally showing
some variation..

3.3.4.8 Buying a house.

So there you are with all your money. You saw a nice little house costing only 100000 dollars plus 10000 dollars federal taxes. So 
you went to see your bank and they agreed to give you an 100.000-dollar loan. You pay the remaining 10000 dollars yourself. You
get two invoices : a first one - worth a 22000 dollars - while signing the  contract, and a second one - worth 88000 dollars - when 
you move in. The company you buy your house from is called 'Happy Housing'.

3.3.4.8.1Setting Things Up

We will have to set up some accounts before we can start entering these transactions. A first account represents the value of the
house. Valuable things like houses, cars… should be recorded in WhereIst? because they represent an important part of your 
total property. Valuable things you own are called 'assets'. Enter the following data for the account representing your house: 

- Name : House
- Description : Whatever you want
- Type : Assets

Leave the other fields as they are.
Create a second account to hold your loan. Enter the following data: 

- Name : Loan
- Description : Whatever you want
- Type : Debts and Liabilities

Next, we will create an account for the taxes we paid as well. This account is a Profit and Loss account: taxes paid are gone. (One could use the 
‘losses – unspecified’ account as well!)

- Name : Taxes
- Description : Whatever you want
- Type : Profit and Loss
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Again, you can leave the other fields as they are. Finally, create one more account with the following details:

- Name : Happy Housing : Invoices to pay.
- Description : Whatever you want
- Type : Debts and Liabilities

Invoices to pay are considered as a debt! So you should assign this account a type 'Debts and Liabilities'!

We need two new expense types as well : 

- Name : Taxes
- Type : Expense

- Name : Investment
- Type : Transfer (paying for a house is not an expense. Your money may be gone, but you get a house for it. So your

financial position does not change!).

And now we are ready to… 

3.3.4.8.2Enter the first invoice

So the first invoice comes in: 22000 dollars. 20000 Dollars are for the house, the remaining 2000 dollars are taxes. Try to enter 
this transaction yourself using the transaction complete dialog. Here are some hints: 

- As soon as you receive an invoice, the value of your house goes up.
- But on the same time, you have a debt to pay to happy housing
- Consider the taxes as paid by the debt you have now with happy Housing. You do not have a debt with the federal government.

Happy housing has.
- You will have to push the ‘Create Expensetype Detail’ button (the one with the small green arrow on the lower right of the

window) yourself to book the investment in the ‘for’ column. WhereDidAllMyMineyGo? does not book transfers itself! 

If you cannot find out how (I do agree this is a difficult one), just look at the screen dump below. 
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Buying a house involves transferring money from your bank account (or from a loan) to the house. You are not getting any richer or poorer 
when buying a house.  Note also that the value of your house goes up with the arrival of invoices (not of payments!).

3.3.4.8.3Pay the first invoice.

This is easier: we can use the ‘Transfer Unspecified’ dialog to register a transfer from our 'Bank account' (10000 dollar) and from 
the loan (the remaining 12000 dollar) to 'Happy Housing : Invoices to pay'. The net result of this is zero: the balance of our bank 
account will drop considerably, but our liabilities at 'Happy Housing' will too! So the whole operation of receiving and paying the 
first invoice did not affect our financial position at all: it just caused a shift from 'liquid money' to 'assets'.
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3.3.4.8.4Enter and Pay the second invoice

This is done exactly the same way as the first one. Take a look at the tutorial file if you do not know how. Note that this time, we 
pay the invoice completely with our loan.

3.3.4.9 BertTorfs Shares go up!

Remember we bought some BertTorfs shares some exercises ago? They were quoted 2000 Belgian Franks each on the Brussels 
stock exchange. Today, you read in the newspaper that BertTorfs shares raised to 15000!. So you open the currency dialog, 
select ‘BertTorfs’ shares and enter 

'1 BT = 15000 Belgian Franks'.

You want to know what that raise meant for you in Dollars? Here is how you can see: 

- Open the ‘Bookings Per Account’ dialog.
- Open (by clicking on the small blue triangle) the ‘Own property’ category.
- Select the account ‘BertTorfs Stock’. As you can see, that account still holds 20 BT shares, worth now 9000 dollars.
- On the lower part of the dialog, you see all bookings on that account in BT. One of them has a value of 0 BT.
- Now click on the tab named ‘Debit-Credit’ split. Here, you see the same bookings again. But now debits and credits (from and to)

are listed in two separate columns. Note how the ‘Credit’ of 0 BT has a local currency value of 7800 dollar. That transaction was
generated when you entered the new value of BertTorfs. (If you double-click this transaction, the ‘Transaction Complete’ dialog
will open with the full details).

- Now click on the tab named ‘Graph’. This will bring up a graph showing the evolution of the selected account (or accounts when
you selected an account type) over time. You’ll see that your account stayed a long time at 2000 dollars, but raised to 9000 dollar
the last month. 

- Now select – in the upper part of the dialog – the account type ‘Own Property’. The graph is redrawn immediately to show the
evolution over time of all your ‘Own Property’ accounts.

- Click on one of the green or red bars in the graph.  A small window showing all the incoming transactions for the month you
clicked opens. Clicking on one of the red bars will open a small window showing all the outgoing transaction in that month.

3.3.5 Further Exploring

There is a second example file coming with WhereDidAllMyMoneyGo? It shows an imaginary stock portfolio 
containg Apple (AAPL) and Sony shares. The AAPL shares are quoted in dollars, the SONY shares in YEN. As I
live in Belgium, the complete picture is kept in Belgian Franks. I entered the quotation of AAPL and SONY and 
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the conversion factor from Dollars to Belgian Franks and from Yen to Belgian Franks abount once a week. 
Just explore the ‘Bookings Per Account’ dialog and you’ll see how gains in AAPL where undone by a falling 
dollar, and how a raise of the YEN was not enough to counter the falling SONY shares.

4 Some theoretical background...

Congratulations for making it trough the tutorial. If you 
understood all the examples of the tutorial, you can completely 
skip this chapter, as you probably know more about accounting 
than I do.
For the rest of us, this chapter describes the theoretical 
foundations of WhereIst?. If you are new to accounting, I 
strongly advice you to lay your hands on a basic accounting 
course, as having some knowledge about double entry 
accounting will definitely improve your usage of WhereIst?
4.1 What is WhereDidAllMyMoneyGo?

WhereDidAllMyMoneyGo? (Its short name is WhereIst? - we'll use that one in the rest of this
document) is a software that can answer the precious question it asks. 
If you want to know how much you spent on fuel last month, how much your car cost, how 
much rent you can afford to pay every month... WhereIst? can help you.
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WhereIst? can easily track of a complex stock portfolio. Shares expressed in different 
currencies do not present any problem. Just enter the exchange rate of these currencies 
from time to time, and WhereIst? will tell you how much you won or lost and why : dollar 
going up, Yen going down, AAPL going up, SONY going down… .
Or if you just want to know how much you posses… .
WhereIst? is based on double entry accounting rules. This does not mean that WhereIst? is 
an accounting package. You can, e.g. modify past transactions without any trace using 
WhereIst?,  something that is not allowed – legal requirements – in a real accounting 
package. 

WhereDidAllMyMoneyGo? was designed to give the home user the same tools as the professional accountant to keep his or her own
accounts, but then without the hassle of legislation.

Of course, there are other packages that do double entry accounting. In fact, any professional accounting package does it. But again, 
WhereDidAllMyMoneyGo? Has some more features that make (or will make) it quite a unique package.

- It is MultiCurrency. You can have different accounts in different currencies and even record transactions between them in other
currencies.  You can transfer e.g. Dutch Guilders from an account expressed in dollars to an account expressed in Belgian Franks.
This might seem unnecessary to you, and if you are living outside Europe and are never travelling, you may be right. But notice
that  Europe will  be introducing the unique Euro-currency at  the end of   98,  so  Europeans will  be stuck with at  least  two
currencies  - the Euro and a national currency - for some time. 

- It can keep track of your shares : price fluctuations will be booked automatically on one or more (one per product) accounts. If you
do not have to many products (physical), you can even use it to track your physical stock : WhereIst? allows you to have an
account expressed in boxes of sugar if you wanted to.

- If you combine these two features - multicurrency and the possibility to keep track of shares - , it means that WhereIst? Can track
the performance of shares quoted in foreign currencies! So you can go and buy these Sony shares quoted in Japanese Yen and
WhereIst? Will exactly tell you how much you won due to stock-price fluctuations and how much was because of that sudden raise
of the Yen. 

- It only costs 25 dollars (you may give more if you really like it:-)). And - although only useful if you pay taxes in Belgium, speak
Dutch  and  have  a  Power  Mac  -  you  get  BelgoFisc  for  free  (or  the  other  way  around  -  registered  users  of  BelgoFisc  get
WhereDidAllMyMoneyGo? for free.). 

- And this price includes all future upgrades published by me - with the exception of an eventual multi-user or Java internet-client
version  (just  dreaming).  And  believe  me,  the  ultimate  goal  of  WhereDidAllMyMoneyGo?  Is  to  be  the  best  single  user
SoHo/Personal/Professional accounting and business package on any platform by far. Sure some way to go, but we'll go it.
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4.2 Double Entry Accounting Terminology.

4.2.1 Account

Simply stated, an account is a container that can hold value or debt. Your wallet is an account, as it can hold 
your money. Your bank account is an account as well. If you borrowed some money from the bank, that loan is
an account as well. The amount of value that is on an account is called its balance.  A wallet containing 100 
dollars has a balance of 100 dollars. A loan of 100 dollars has a balance of 100 dollars as well. (Not of minus 
100 dollars as you might have thought). A bank account with an overdraft has a negative balance.

Accounts can be grouped in at least two categories : these you want to have a high balance (your own property) and those you want
to have a low balance (your debts). The first type of accounts are called 'Property Accounts', the second type are 'Liability Accounts'. 

To glue everything together, a third type of account is needed : this type is called 'Profit and Loss Accounts'. They represent all external sources 
or destinations of value (the grocery store, your employer, the tax man...). Accounting is nothing but shifting value between accounts of these 
three types.

4.2.2 Transaction

A transaction is the record of a shift of value from one account to another. Transactions can describe a 
transfer between accounts, an expense or an income. WhereDidAllMyMoneyGo? even allows to register 
transactions that are a mix of these.
The balance of accounts can only change because you record transactions against them. 

- Income moves value from a 'profit and loss' account to an 'own property' account (e.g. receiving your salary from your employer),
or from a 'Liability' account to a 'profit and loss' account.

- Spending money moves value from an 'own property' account to a 'profit and loss' account, or from a ‘profit and loss’ account to a
‘liability’ account. 

- A transfer moves money between two ‘own property’ accounts (from your bank account to your savings account), between two
‘profit and loss accounts’, between to liability accounts (converting a short term loan into a long term loan) or between an ‘own
property’ account and a ‘liabilty’ acount (Taking money from your loan and place it on your bank accounts. Your financial situation
does not change if you transfer money. Borrowing money from the bank to put it on your own bank account is a transfer. The
balance of both accounts will go up in this case.
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4.2.3 Expense Type

An expense type is a reason for which you spend or receive money. The name expense type is a somewhat 
unhappy choice, as it is used for income as well as well as expenses. Possible values of expense types are 
'Food', 'Fuel', 'Rent', 'Salary'. 

4.2.4 Double Entry Accounting : 

And here we are back: double entry accounting.
Why double entry accounting? And what are the alternatives.

Most personal Budget packages allow you to register a spending of money in terms of a series of accounts (where did the money
come from) and a series of Expense Types (Why was it spent). Income is expressed in terms of a series of expense types (Why did
you get this money : salary, lottery...) and a series of accounts (where did it go to : wallet, bank account... .). The better packages
allow you to enter transfers between accounts as well: transferring money from your bank account to your savings account e.g. .

Double entry accounting forces you to enter every single transaction in terms of two series of accounts: one or more from-accounts (the debit 
side) and one or more to-accounts (the credit side). Transactions move value from a set of accounts to another set of accounts. 
Some examples to clarify: 

- An easy one: You transfer 100 dollars from your bank account to your savings account.  The from account is your bank account,
the to account is your savings account. This is a transaction between two property accounts. A transaction like this is represented
as : 

From To

My Bank account $100 My Savings Account $100

Note that the totals from the 'From' side and 'To' side (or the debit and the credit side) must match! The result of this operation is
that the balance of your bank account goes down 100 dollars and the balance of your savings account goes up. Your total property
does not change. Transactions of this type are called 'Transfers'.

- A little bit more difficult: You take 100 dollars from your loan and put it in your pocket. In this example, the 'From' account is the
loan and the 'To' account is your pocket. This is a transaction between a 'Property' and a 'Liability' account. This is represented by
this booking : 
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From To

My Loan $100 My Pocket $100

Note here one important thing: the balance of a property account goes up if you transfer money to it. The balance of a liability
account goes up if you take money from it! After this transaction, the balance of your wallet is 100 dollars and the balance of your
Loan is 100 dollars as well. How much do you own now? Zero!. Your total value (in terms of possessions) is the sum of all your
Property accounts minus the sum of all your liability accounts. Sounds logic, doesn't it.?

This transaction is a transfer as well, as your total possessions do not change.

- A third example: You go to a shop and spent 100 dollars pocket money. The 'From' account is your pocket and the 'To' account is
the shop. Your pocket is a property account. And the shop? No, it is not a liability account! You have paid what you bought, so you
do not owe anything to the shop anymore. That is where Profit/Loss accounts come in : they are used to register external sources
or destinations of money. 

From To

My Wallet $100 The Shop $100

In stead of using the account 'The shop', we could have created an account called 'General Expenses' (WhereIst? names this account 
'Unspecified expenses') which could then be used for any shop. That is how it is done in practice as well : one account is created for 
every destination of money and only for some important shops, you create a specific account. So if one shop offers you a free bottle 
Chateau Petrus '86 at the end of the year if you spent over 1000$ during that year, it would be a good idea to create a separate 
account for that shop. Just looking at the balance of that account would show you if you are still in the running for that bottle. All 
other shops are booked into one 'General Expenses' account. 

A double accounting system forces you to create equal from and to sides for every transaction you enter.
So far so good, but how do you know how much you spent on food last year using pure double entry accounting?

4.3 Another Approach: Account - Expense Type

Most popular home budget packages use another way to enter transactions : for spending, 
you have to specify one or more 'From' accounts and one or more Expense Types. An 
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expense type is a code that tells what you spent the money for. Valid codes could be 'Food', 
'Fuel', 'Gas'. 

You want an example on this?

-If you go to the shopping mall and you spend - from your wallet - 100 dollars on clothes and 50 dollars on food, you would have to 
enter something like : From My wallet : 150 dollars for Food (50 dollars) and Clothes 100 dollars). 

From For

My Pocket $150 Clothes $100

Food $50

Just like the double entry accounting system, this approach forces you to have equal amounts on both sides of the transaction.
Entering transactions this way allows you to answer the question 'How much did I spend on food last year'. But you have no way of knowing if 
you spent the 1000 dollars at that particular shop last year that entitle you to a free Chateau Petrus '86.
As you might notice, a double entry accounting system is ideal to answer the question 'How rich am I'. It is ideal to study your financial 
situation. And that is why all major companies use this system: it gives an excellent overview of their financial health at a given moment. But to 
answer the question 'How much did I spend on fuel', the account-expense type notation is more adequate. And that is why, separate from their 
double entry accounting system (mostly called the 'General Ledger'), major companies keep what they call an 'Industrial Accounting'. The 
industrial accounting tracks expenses and income against expense types. (Really big companies add even other dimensions like cost centers to 
track where the money was spent (which department)).

Of course, if you would be using a pure double entry approach, you could create a profit and loss account called 'Fuel Expenses' to
track your spending on fuel. But Imagine you want to track how much you spent at the shopping mall, how much you spent at the
Grocery Store, how much you spent on food and how much you spend on clothes. Using double entry accounting only would force
you to create an account 'Shopping Mall Food', 'Shopping Mall Clothes', 'Grocery Store Food' and 'Grocery Store Clothes'. You'll soon
arrive with a huge and impractical number of accounts this way. And that is where WhereDidAllMyMoneyGo? comes in : 

4.4 Best Of Both Worlds

So far the background information. Lets talk WhereDidAllMyMoneyGo?.
WhereDidAllMyMoneyGo? is a double entry accounting program. But it adds to this the 
power of the Account - Expense Type approach. How? Well, by adding a third dimension to 
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any transaction you enter. The first dimension is the 'from': where did the money come from. 
The second dimension is the 'to' : where did the money go to. And the third dimension is the 
'For': what was it spent  - or gained - for.
An example will clarify this : Imagine a shop called 'BuyItFromMe'. If you buy for over a 1000
dollar a year at 'BuyItFromMe', you get an excellent Chateau Petrus '86 for free. So you 
definitely want to track your spending there. One fine day, you go there and spend 100 
dollars cash. 50 Dollars is spend on food, 20 dollars on clothes and the remaining 30 dollars 
on fishing equipment. Using WhereDidAllMyMoneyGo?, you could enter this transaction like 
this : 

From To For

MyWallet $100 BuyItFromMe $100 Food $50

Clothing $20

Fishing 
Equipment

$30

 

Entering transaction this way provides WhereDidAllMyMoneyGo? with all the information it needs to answer all kinds of questions on your 
financial situation.

Having to enter transactions in three dimensions can be overkill if you want to record your daily spending. You probably do not care at which 
shop you buy your bread. For quite a lot of money flows, you do not care where they came from or where they go to : knowing they happened 
and why is enough. To facilitate entering these transactions, WhereIst? has two predefined accounts : an 'Unspecified Income and an 
'Unspecified Expenses'. Two simplified windows allow you to book transactions against these. The expense type is always mandatory.
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5 Using WhereDidAllMyMoneyGo? - Getting Started

This fifth chapter contains some guidelines on how to use 
WhereDidAllMyMoneyGo?. You can see it as an extension to the
tutorial. It has three sub-sections: 

- Using WhereDidAllMyMoneyGo? covers topics like 'how does a typical WhereIst? dialog look like  and  'how do I use a popup-list'.
- Setting-up describes the master data to enter when setting up WhereDidAllMyMoneyGo? for your own needs.
- Entering transactions describes the ways you can enter transactions in WhereIst?.

5.1 Using WhereDidAllMyMoneyGo?

All WhereDidAllMyMoneyGo?-dialogs are operated the same way. If you know one, you 
know them all. This section describes the similarities between all these dialogs.



WhereDidAllMyMoneyGo : User Guide Page 35
5.1.1 Parts of a typical dialog

A typical WhereDidAllMyMoneyGo? dialog. Left, you see the list, on the right side are the details.

This picture shows a typical WhereDidAllMyMoneyGo?-dialog. On the left hand side, a list of all objects of a given type is displayed. The right hand side shows the 
details of the selected object. The example shown here lists all accounts. The details of the selected account  appear on the right hand side.
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5.1.2 The list

The table at the left hand side of most of WhereDidAllMyMoneyGo?'s dialogs is called (surprise surprise) 'the 
list'. You can navigate trough the list using one of the following techniques: 

- Clicking a row
- Using the <arrow-up> or <arrow-down> keys to select the item immediately below or above the current selection.
- Using the scroll bars to scroll trough the list.

(No, you cannot yet type the name of the line you want to select).
Using the scroll bars will not change the selection.
The selected row is indicated by a colored filled rectangle. If the list is active, that rectangle will be solid. If the list is not active, that rectangle 
will be hollow. You can make the list active by clicking on it. The list will become inactive if you click another part of the dialog. Activating and 
de-activating the list works very similar to selecting windows in the finder.
If you scroll trough the list using the arrow-up arrow-down keys, or if you click another row, the details displayed on the right hand side will 
change so they reflect the newly selected row. 

5.1.3 The details

The details of the selected object are shown on the right hand side of the dialog. This part of the dialog 
behaves like a standard Macintosh dialog box. You can jump from field to field by using the <tab>-key. You can
cut-copy-paste data between the different fields using the standard <Command-X-C-V> shortcuts. There is one
special type of control that is not part of the standard Macintosh toolbox that requires special attention: the 
Pop-up list. 

5.1.4 Pop-up Lists

Pop-Up lists are easily recognizable by a small down-pointing arrow placed just to their right. This arrow acts 
as a button. Clicking it will reveal a list with al the possible values you can enter in the pop-up field.
Pop-up lists can be opened either by clicking the button, by clicking the pop-up field or by tabbing to the 
popup-field. Pop-up lists can be closed by tabbing away from the Pop-up field, by clicking another field or by 
clicking the little arrow. There are multiple ways to select a value from a Pop-up list.
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A Pop-up list

There are several ways to select an item from a popup list: 

- Click the record in the lists. You can use the scroll-bar to scroll to the right record.
- Start typing the name of the record. WhereDidAllMyMoneyGo? will scroll to the record matching what you typed. Push 'Enter',

'Space' or 'Tab' once the item you want is highlighted.
- Use the up- and down-arrow to navigate trough the list. Push 'Enter', 'Space' or 'Tab' once the record you want is highlighted.
- Type the ID of the record you want, followed by 'Enter', 'Tab' or 'Space'. This is the fasted way, but assumes you know the Ids. 
- Drag the item you want from the list part of another dialog onto the edit-part of the popup-list. This is maybe the easiest way to

search for items in long lists.

5.1.5 How to use it.

5.1.5.1 Modifying existing objects

Select the record you want to modify in the list. Tab over the details and modify wherever appropriate. Be careful, as 
WhereDidAllMyMoneyGo? does not yet offer an undo functionality! All your modifications are immediately recorded in memory.

5.1.5.2 Creating New Objects

Select 'New...' from the 'Edit Menu'. A fast alternative is to enter <Command-K>. A new object will be inserted with some default 
values. Tab over the details to modify these. Selecting another object or trying to close the dialog will validate your entry and 
commit the newly created record.
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5.1.5.3 Deleting objects

Just select the record you want to delete. Select ‘Delete’ from the menu. The only objects that can be deleted in 
WhereDidAllMyMoneyGo? are transactions and accounts.

5.1.5.4 Copying Transactions

WhereDidAllMyMoneyGo? allows you to copy complete transactions using the familiar <CMD-C/V/X shortcuts. Just select the 
transaction you want to copy from in the list, press <Cmd-C> followed by <Cmd-V> and you are done. Transactions are currently 
the only objects that can be copied this way.

You can copy between transactions and recurring transactions this way as well. Be sure that the list part of the transaction dialog is selected when
you copy or paste. Otherwise, the contents of the clipboard will be pasted into the selected field.

5.2 Setting-up.

Before you can start recording transactions, there is some information you should set-up. 
This information includes Account Owners, Currencies, Account Types, Accounts, Master 
Expense Types and Expense Types. Some default registrations for these are generated by 
WhereIst?. 

5.2.1 Master Account Types

Master Account Types are the highest level of account classification. However, you cannot set them up 
yourself. : WhereDidAllMyMoneyGo? creates them for you and you cannot modify them.  There are four 
Master Account Types : 

Name Id

Own Property Accounts 1

Liability Accounts 2
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Profit and Loss Accounts 3

Assets

The first three types are described in the chapter 'Some theoretical Background'. An asset is a special kind of ‘Own Property’. An account of 
type 'Asset' holds valuable goods like a house, a car etc... . Assets do add up to your own property. Assets are normally written off during a 
certain period. Assets can be tangible (a house) or intangible (a license to sell a product).

5.2.2 Account Types

Master account types are system defined: you cannot modify them. If you feel the need to, you can do this by 
defining your own account types. Every account type is derived from one of the four above-mentioned Master 
Account Types.
WhereDidAllMyMoneyGo? creates 4 default Account types : one for each of the 4 master account types. These
types have the same name and description as the master account type they are derived from, but this time, 
you can change them yourself. You can add as many account types as you wish, as long as they are derived 
from one of the four master account types. Account types are the highest level of analysis. 
WhereDidAllMyMoneyGo? automatically and continuously consolidates account balances up to  account type 
level

5.2.3 Account owners

Account owners are the people or organizations that own accounts. WhereDidAllMyMoneyGo? creates one 
default Account Owner, called 'Me'. You can change this if you would like to or add your own account owners.
Account owners are not too important in the current release of WhereDidAllMyMoneyGo?. I just added them to
be save when I wantto turn WhereIst? into a multi company system. And they will be used as ancestors for 
suppliers and customers when accounts payable and accounts receivable extensions are added.

5.2.4 Currencies / Account unit of measures.

Accounts can hold value. Values are normally expressed in a currency. WhereDidAllMyMoneyGo? creates one 
default (or home) currency whose initial name is copied from the international settings of your Mac. This name
can be modified if you would like to. The default currency has an Id-value of 1. This cannot be modified!
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For any additional currency you define, you must supply WhereDidAllMyMoneyGo? with a conversion factor 
to the home currency.
An extremely powerful feature of WhereDidAllMyMoneyGo? is the possibility to express this conversion via an
intermediate currency. The most obvious use of this feature is to define shares expressed in foreign 
currencies as just another currency. 
En example to clarify : 

Your default currency is Dollar (Short '$')
An alternative currency is Belgian Franks (Short Bfrs). Conversion from Belgian Franks to dollars is done using the formula '100 Bfrs
= 2.93 $'.
At the Brussels Stock Exchange, you can buy 'Delhaize' stock for 4000 Bfrs. You can define a currency called 'DLHZ'. The conversion 
formula for ‘DLHZ’ is  '1 DLHZ = 4000 Bfrs'. Because WhereIst? can convert now from DLHZ, to Bfrs, and it knows how to convert 
Bfrs to dollar, it knows how to convert DLHZ to Dollar as well.

5.2.5 Accounts

The heart of WhereDidAllMyMoneyGo? are accounts. Accounts reflect where your money is, where it came 
from and where it went to. 
For any account, you have to enter at least following information: 

- A number : accounts can be numbered manually. All other objects are numbered automatically by WhereDidAllMyMoneyGo?.
- A name.
- A type. Please pay attention while assigning types - and by consequence master types - to accounts!  Assigning the wrong type -

especially the wrong master type - to accounts will screw up your personal accounting completely!
- A currency. By default, accounts are expressed in your home currency. You can, if you want to, express an account in another

currency.

WhereDidAllMyMoneyGo? creates four default 'Profit and Loss' accounts. You can keep them or change them if you would like to. Note however
that WhereDidAllMyMoneyGo? makes use of  these accounts as default accounts. If you choose to modify these accounts or to change their 
type, you should create new default accounts or some options of WhereDidAllMyMoneyGo? will not work properly anymore.
The four default accounts are : 

- ‘Profits : Unspecified’ : used to book any incoming money you do not care where it came from. This account is used as the 'From'
account by the 'Transactions => Transactions : Simplified => Unspecified Income' dialog.

- ‘Losses : Unspecified’ : used to book any outgoing money you do not care where it went to. This account is used as the 'To' account
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by the 'Transactions => Transactions : Simplified => Unspecified Expenses' dialog.

- ‘Corrections’  :  If  you change the balance of  an account,  WhereIst?  will  create a transactions that uses this  account  as the
matching account. WhereIst? uses this account  as default account to book profits and losses due to currency fluctuations as well. 

- ‘Default Own Property Account’ : you should change the name of this account to match your default own property account.

As mentioned earlier, you can modify these accounts or create your own default accounts. But note that WhereDidAllMyMoneyGo? needs 
default accounts to function properly. Please check the preference window after you modified the default accounts!

5.2.6 Master Expense Types

Just like accounts are grouped in two levels (account types that can be created by the user and master 
account types that are system defined), expense types are grouped in two levels as well. The higher level – the
one that cannot be modified – contains the following entries:

- Expense
- Income
- Transfer
- Opening Balance
- Correction

Derived from these are the master expense types. Initially, WhereIst? creates one for each of the abovementioned system types, but you can 
create as many of them as you wish. Master expense types are used to group – for analysis purposes – expense types. (Just like account types 
are used to group accounts). You can create e.g. a master expense type ‘Car’ to group all the expense types related to your car ,like ‘Fuel’, 
‘Insurance’, ‘Maintenance’ etc… . 

Future versions of WhereDidAllYourMoneyGo? will allow you to group these master expense types hierarchically. Restructuring master expense types
will be a matter of simple drag&drop. All levels will be consolidated automatically.

5.2.7 Expense Types

While accounts are used to keep track of where your money is, came from or went to, expense types keep 
track of the reason why you spent or earned this money. Just like it does for accounts, 
WhereDidAllMyMoneyGo? creates some default expense types. These are:

- Corrections
- Currency Fluctuations
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- Income: Unspecified
- Expense: Unspecified
- Opening Balance
- Transfer: Unspecified

You are free to create as many expense types as you want. Existing expense types can be moved to another master expense type, as long as it 
remains of the same type (expense, income or transfer).

5.3 Setting Preferences

Once you defined all your accounts and expense types, you can assign accounts and 
expense types to perform specific functions.  This is done via the ‘Preferences’ dialog.
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Defining some default accounts.

The 'Password' feature is not yet elaborated in release 1.0!.1 To get some explanation on the meaning of these items, start up WhereIst?, open the preferences 
dialog and turn on balloon help.

1For your information : the heart of WhereDidAllMyMoneyGo? is capable of handling and serializing updates from multiple users a
the same time. Making a multi user client-server version of WhereIst? should not be too difficult.
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5.4 Entering Transactions

WhereDidAllMyMoneyGo provides multiple ways to enter transactions. Some of them are 
manual, some are automatic. The manual ways are:

- By using the full three-dimensional 'Transactions Full' dialog. This option is valid for all kinds of transactions.
- By using the 'Unspecified Income' dialog. This dialog is used to register money coming from the account that you specified as the

default 'Unspecified Income' account (In the preference panel). You only have to complete the two remaining dimensions: where
did the money go to and what did you gain it for. 

- By using the 'Unspecified Expenses' dialog. Use this dialog to record expenses if you do not mind where the money went to. The
'To' account will be copied from the preference settings. You only have to enter the two remaining dimensions: 'From' and 'For
(expense type).

- By using the 'Unspecified Transfer' dialog. For transfers, you normally don't bother why you did it (the expense type). This window
will use the default 'Transfer Expense type' (as specified in the preferences dialog), so you only have to provide the two remaining
dimensions: 'From' account and 'To' account.

The automatic ways are: 

- By changing the balance of an account. WhereDidAllMyMoneyGo? will create a transaction to correct the balance. The profit and
loss account that will be used to match the from and the to sides is the one you specified as  'Opening Bal./Corrections'  in the
preference dialog.

By changing the conversion factor of a foreign currency. WhereIst? will create correction transactions to correct the balance of each 
and every account that is either directly or indirectly expressed in that currency.
Every time you start up WhereDidAllMyMoneyGo?, it will check if no recurring transactions are to be generated. If so, it will do so. 
Transactions generated that way will either be added to the list of effective transactions or to the list of unlinked transactions. 
Unlinked transactions must be approved (choose ‘LinkTransaction’) before they become effective.

And of course, you can copy and paste transactions between all the transaction-entry windows.
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5.4.1 Manual Transactions : The complete dialog. 

We will only explain the <Transactions Complete> dialog. The simplified versions are essentially the same with just one dimension cut out.

If your monitor is set to a resolution less than 800*600, the transaction complete dialog looks slightly different. The contains all the same elements,
but positioned differently.
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Just like any master data window, the transaction window contains a list side and a detail side. The detail side is somewhat more complex.
To enter a new transaction, just type <Command-K> (or select 'New Transaction' from the 'Edit' menu). The details of a full transaction contains four parts: 

- Header info: describes the transaction
- ‘From’ info: describes where the money came from
- ‘To’ info: describes where the money went.
- ‘For’ info: describes what the money was spend (or gained) for.

All these parts are updated every time you select another transaction from the list.

Entering the header info is quite straightforward: just tab over the fields and enter a value. The amount entered on the header will 
automatically be copied to the three details.  In case your transaction contains more than one 'From', 'To' or 'For', you should enter a value for 
the header amount. 
When you enter a transaction amount, it will be copied to the transaction details. If you then modify one of these details and press <Tab>, a 
new detail will be generated for you with an amount that is the difference between the transaction amount and sum of the detail amounts. An 
example : 
Imaging you enter 100 on the header. That 100 will be copied to the first 'from', 'to' and 'for' details. If you then change the 100 to 25 on the 
first ‘From’ account, WhereDidAllMyMoneyGo? will automatically generate and show a new ‘From’ detail for the remaining 75.
If you leave the header value to 0, WhereDidAllMyMoneyGo? will not generate any additional details. You will have to take car for matching the 
tree dimensions of the transactions yourself.
You can delete or create individual transactions details by pressing one of the little buttons above each category. The button with the small 
green arrow inserts a new detail, the one with the small red arrow removes the current detail. (Click on the amount of the detail you want to 
remove to make it current). 
WhereDidAllMyMoneyGo? stops you from closing the transaction window or from changing the selection in the list as long as totals for 'From', 
'To' and 'For' do not match!.

5.4.2 When to use the 'Simplified' windows?

For home-users, having to enter both accounts and expense types is often considered as an overkill, as 
expense types and accounts will often express one and the same thing. All salary will come from your 
employer, so you could define your employer as an account. However, as you are likely to define 'Salary' as an
expense type as well, the 'Employer' account might seem unnecessary duplication of data. For such cases, 
WhereDidAllMyMoneyGo? provides some simplified transaction-entry windows. These windows are just 
copies of the full window but with one of the three dimensions cut-off.

- The 'Unspecified Expenses' can be used if you do not care which account the money went to. Only the 'From' and the 'For' must be
entered. WhereDidAllMyMoneyGo? will use the account specified as 'Default account for unspecified expenses' in the preference
dialog as the 'To' account.

- The 'Unspecified Income' can be used if you do not care which account the money came from. Only the 'To' and the 'For' should be
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entered. WhereDidAllMyMoneyGo? will use the account specified as 'Default account for unspecified income' in the preference
dialog as the 'From' account.

- The 'Unspecified Transfer' can be used if you do not care why the money was transferred. You just have the enter the 'From' and
the 'To' account.

Transactions entered using the 'Simple' dialogs can be viewed and modified with the 'Transactions Complete' dialog. The 'Simple' dialogs only 
show transactions created with that dialog. The complete dialog shows all transactions.

5.4.3 Recurring Transactions

Some transactions come back regularly. Having to type them in every time they occur is just boring. You can 
instruct WhereIst, to generate these transactions by creating a recurring transaction. The differences between 
a recurring transaction and a real transaction are :

Recurring transactions do not change the balance of the accounts the debit, credit or ‘expense type’.
Recurring transactions contain some information normal transactions do not. This information is used to instruct WhereIst? when it 
should generate a recurring transactions. This information is accessible via the ‘How To Generate’ tab of the recurring transactions 
dialog.

The ‘How To Generate’ tab of the recurring transaction dialog. This screenshot instructs WhereIst? to generate a transaction the
last Friday of every month.

If you uncheck ‘Generated Transactions are Valid By Default’, the generated transactions will be added to a list of ‘transactions to approve’ 
(called unlinked transactions as well). These transaction 
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5.4.4 Transactions that are generated for you by WhereDidAllMyMoneyGo?

The balance of an account equals the sum of all bookings to it minus the sum of all bookings from it. If the 
balance of an account does not match reality, you should create a transaction to correct that. However, just 
going to the transaction definition dialog and typing in the new balance might seem to be much easier.  Right 
you are. If you modify the balance of an account, WhereIst? will take care of the balancing transaction. 
The same is true for a change in currency conversion factor. If a currency devaluates (or revaluates), or if a 
share rockets through the sky, your own property goes up or down as well. Also in this case, 
WhereDidAllMyMoneyGo? will take care of the balancing transaction for you. All you have to do is enter the 
new conversion factor, and all the balancing transactions – one for every account expressed in that currency –
will be generated immediately.
These automatic transaction cannot be modified or deleted!.

6 Beyond the Basics

This chapter contains some unrelated tips and techniques for 
people familiar with the basic usage of 
WhereDidAllMyMoneyGo?. If you read the previous chapters 
and feel comfortable with the  complete transaction window, 
you are ready to continue.
6.1 Multi-Currency

WhereDidAllMyMoneyGo? is a multi currency application. Any account can be expressed in 
any currency. Any transaction can take value in any currency from an account and put it in 
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another account in another currency. You could move dollars from your bank account and 
put it as Belgian Franks in your wallet and take it out of there as Indian Rupees if you felt like
doing so. WhereDidAllMyMoneyGo? will do the necessary conversions for you and check 
that 'from', 'to' and 'For' sides of all transactions match.

6.1.1 Local Currency

Most people just use one currency: people living in the USA will probably only use Dollars. The currency you 
or your organization uses day-in day-out is called your local currency. 
Every WhereDidAllMyMoneyGo? document has one and only one local currency. This is the currency that will 
be used internally by WhereDidAllMyMoneyGo? to validate each and every account. Technically, the local 
currency is the currency with Id = 1. You cannot create or delete a local currency: WhereDidAllMyMoneyGo? 
creates it for you. You can only change its name. (Future versions will allow to select any currency as the local
currency and to change your local currency as many times as you want. This to be ready for the final 
introduction of the Euro currency across Europe).
By default, WhereDidAllMyMoneyGo? uses the currency-label defined in your machines international settings 
as the name of the local currency. 

6.1.2 Foreign Currency

Your local currency might not be the only currency you work with. If you are a frequent traveler, you might 
have a bank account expressed in some foreign currency. 
WhereDidAllMyMoneyGo? allows you to define as much foreign currencies as you wish, as long as you tell 
how amounts expressed in that foreign currency can be converted to your local currency. This conversion 
factor is entered as : 

x Foreign Currency = y local currency
or, more concrete

100 Belgian Franks = 2.97 American Dollars

where 'American Dollars' is your local currency and 'Belgian Franks' is a foreign currency.
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6.1.3 Shares expressed in a foreign currency.

WhereDidAllMyMoneyGo? allows you to express a currency in terms of another currency. If your home 
currency is 'American Dollars' and you buy 'Delhaize' shares on the Brussels stock exchange, you could 
create a currency (note that the name ‘currency’ is a bad choice in this case) called 'Delhaize Stock'. The 
currency 'Delhaize Stock'  is expressed in 'Belgian Frank'.

1 Delhaize = 2000 Belgian Frank

As a result of this, WhereDidAllMyMoneyGo? will know that 1 Delhaize is worth 59.4 American Dollars. When converting to your local currency, 
WhereIst? can cascade conversions an unlimited number of levels deep to convert between any currency and your home currency.

6.1.4 Expressing an account in a foreign currency

Most people will only have accounts expressed in their local currency. However, you can express accounts in 
any currency known to WhereDidAllMyMoneyGo?. Just select that currency from the list when defining an 
account.
WhereDidAllMyMoneyGo? keeps account balances in two currencies : your home currency and the currency 
in which the account is expressed. Any accumulations are only performed in your home currency, as it does 
not make any sense to add dollars to Belgian franks.

6.1.5 Changing the Currency Of an account…

…can be done but can be dangerous. If you change the currency of an account, WhereDidAllMyMoneyGo? will
convert the balance in foreign currency to calculate the new local currency balance. You should normally 
never have to do that! 
One case where you might have to change the currency of an account is when the European unique currency 
(the EURO) will be introduced! All European bank accounts will be converted into Euro from that moment on. 
WhereDidAllMyMoneyGo? will include the possibility to change you home currency - not just its name - by 
then!

6.1.6 Changing Rates

Currency rates are not fixed. They change, sometimes even dramatically, over time. So currency rates should 
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be modified from time to time. Because of this, the balance - in local currency - of accounts will change as 
well.

If you own 1000 Delhaize shares, and the share value goes up from 2000 to 4000, the local balance of your account will jump from
2000000 to 4000000 (assuming your local currency is Belgian Franks). The foreign balance will not change : there as still 1000
Delhaizes on your account.

The local balance of an account can only be changed by a transaction. WhereDidAllMyMoneyGo? will create these for you when you change the 
conversion factor between two currencies. Changing the Delhaize price will cause following transaction to be generated: 

From To For

Currency 
Fluctuations

2000000 Delhaize Shares 2000000 Currency 
Fluctuations

2000000

 

The value in foreign currency of this transaction will be zero. Note that you cannot accomplish this using the standard transaction entry dialogs,
as these will always balance local and foreign amounts!.
The 'From' Account and the 'For' expense type are copied from the currency definition (look at the dialog Setup=>Currencies if you don’t 
remember). This allows you to have a different account for expense types for all currencies, so you know in detail how much you won/lost due to
currency fluctuations of every single currency.
If that same Delhaize share drops back to 2000, changing the conversion factor will cause the following transaction to be generated : 

From To For

Delhaize Shares 2000000 Currency 
Fluctuations

2000000 Currency 
Fluctuations

-2000000

6.1.7 Changing Your Local Currency

You cannot change the local currency in the current release of WhereDidAllMyMoneyGo?. You can only 
change its name. 
Assume your home currency is 'American Dollars'. One dollar equals 2 (approximately) 'German Mark'. 
Changing the name of your local currency from 'Dollars' to 'Belgian Franks' will still keep  that 1 against 2 
conversion factor, which is definitively wrong : you need about 22 Belgian Franks to buy one dollar.
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All you can do is change the name of your home currency from 'American Dollar' to 'Dollars Of America'.  By the time Europe
switches to the Euro currency, WhereDidAllMyMoneyGo? will allow to change the home currency.

6.1.8 Buying Foreign Currency

Imagine you have two currencies defined: US Dollars and Belgian Franks. US Dollars are your home currency. 
100 Belgian franks are rated 3 US Dollars.
One fine day, you want to travel to Belgium, so you need Belgian Franks. You go to the bank and buy 1000 
Belgian franks. You are charged 35 dollars: 1 dollar expenses and 34 dollars for the money itself.
How can this be booked?
Like this: 

From To For

Bank 
account

35 $ Unspecified 
Expenses

1 $ Commissions 1 $

Pocket money 1000 Bef Unspecified Transfer 1000 Bef

Currency 
Difference

4 $ Currency Differences 
Belgian Frank

-4 $

You can just enter the amounts as described above: WhereDidAllMyMoneyGo? will handle the conversions. While entering the 'To'
column, WhereDidAllMyMoneyGo? will first propose an amount of 35 dollars. If you change it to 1, a new row will automatically be
created for the remaining 34 dollars. When you change the currency to 'Bef', WhereDidAllMyMoneyGo? will automatically convert
that 34 dollars to 1100 Belgian Franks. This is the amount in Belgian franks based on your standard conversion rate. However, you
only received 1000 Belgian franks, so you change the amount to 1000. A new row for the remaining 4 dollars is created. All you have
to do still is to enter the account against which these 4 dollars should be booked. And that is a Profit and Loss account called
'Currency Differences'. (You could have used 'Unspecified Losses' as well).

6.2 Handling Stock

Although WhereDidAllMyMoneyGo? does not (yet) include an accounts payable/accounts 
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receivable modules (I am thinking of it!), you can use it to a certain extend to handle physical
stock.
Imagine you want to keep a stock of bottles of milk.

How?

Just create a currency 'MILK : Bottles of Milk'. One bottle of milk is worth one dollar, so that 
is your conversion factor. Now create an account 'My stock of milk' (own property) that is 
expressed in 'Milk' and ready you are! You can put or take milk from your stock and its 
balance in local currency will be adjusted accordingly. If the milk price is raised, you just 
have to change the conversion factor and bingo!, your stock is re-valued.
The only thing that does not work yet is the 'Allow Decimals' flag on currency level. You can 
take half bottles of milk from your stock without having WhereDidAllMyMoneyGo? 
complaining.

7 Year 2000

If you enter ‘01-01-00’ for a date, WhereDidAllMyMoneyGo? will 
iterprete it as Januari 1st, 2000. ‘01-01-10’ will be interpreted as 
januri 2010. From Entering 11 or greater for the year will be 
interpreted as 1911. You can, of course, always enter the year in 
4 digits.
The conversion of dates, by the way, is handled by the MacOs. I 
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did not have to code anything into WhereDidAlMyMoneyGo? to 
get this behavior.
The above is true for System 8.5. I did not test it out on older 
system versions. But knowing Apple, it would surprise me if 
they ever had any year 2000 problem.

8 Final word

(Waiting for inspiration/having to code. Maybe later.)


